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SMART Board Interactive Whiteboard Basics

Introduction

The SMART Board"" interactive whiteboard is a touch sensitive display that you connect to your
computer:

» The computer sends an image of an application to the projector
* The projector casts the image onto the interactive whiteboard

» The interactive whiteboard acts as both the monitor and input device, letting you control any
application by touching the screen

» Anything you can do on your computer, you can do on the interactive whiteboard

You can use an interactive whiteboard instead of flip charts, whiteboards, overhead projectors and
chalkboards:

» Use SMART Notebook software and SMART Board tools to create, save and reuse engaging
learning materials

* Integrate audio, video and the Internet into your lessons

» Encourage collaboration and interaction



Orienting the SMART Board interactive whiteboard

Orienting the SMART Board interactive whiteboard tells the computer where the image is projected
on the interactive whiteboard. Complete this process in any of the following situations:

* When you set up the interactive whiteboard
* When you have moved the interactive whiteboard or the projector

» When the interactive whiteboard does not interpret your touch accurately

Action Method

Orient the SMART
Board interactive
whiteboard

OR

Pras canter ol target sed rnlnaws

Hands-on Practice

Try the following tasks to test your knowledge

D Connect your computer to the SMART Board interactive whiteboard

D Orient the SMART Board interactive whiteboard
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Touch, write and save
Introduction

Anything you can do on your computer, you can do on your interactive whiteboard:
» Use your finger as a mouse

» Use the pen tools to write

» Use the Eraser tool to erase your notes

» Use the On-screen Keyboard to type

Using your finger to input information

Action Method

EZ Keyboard -- English [United States) (ENU)
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k:"qwerlyuiop[]"\ s || Home
G lafs|diffflah|i|k|1]:]|" — bet || Ena || rgon
G =] xfefv]efnm] I [/]¢] [*]
m [ = e = ] [ = (@S] =] [«]+]~]




Writing on the interactive whiteboard

When you pick up a pen tool, a border appears around the desktop. This border indicates that the
Digital Ink Layer (a fixed image of your desktop) is in place. It lets you write on your interactive
whiteboard without affecting the applications that you are displaying.

When you return all pen and eraser tools to the pen tray and touch the interactive whiteboard, a
menu appears allowing you to clear or save your notes, and close the Digital Ink Layer.

Digital Ink
Layer border -

Clear writing  Save writing

¢ + ' Close Digital Ink
ﬂ Layer

Action

Method

Write

+

Consider the following points when you are writing on the interactive whiteboard:

» The SMART Board interactive whiteboard recognizes the last tool that you picked up

» Each pen tool slot has an optical sensor that detects when that pen is not in the pen tray. A light
in each tool slot indicates which tool is active.

» The digital ink is the color of the last pen you picked up, regardless of which pen you use or how
many tools you have removed from the pen tray

» Once you remove a pen tool from the tray, you can use your finger to write on the interactive

whiteboard




Erasing digital ink

Action Method

Erase some of your
notes

Clear all of your
notes

Sawve Ink

I _ Always Save Ink
- I Ink Layer Cptions. ..

Clear Ink

Close Ink Layer

Saving digital ink

You can save your notes and drawings as a SMART Notebook software file.

Action Method

A i (0 )&

Blways Save Ink
Ink Layer Ophions. ..

Clear Ink
Close Ink Layer




Closing the Digital Ink Layer

Close the Digital Ink Layer when you finish writing on the interactive whiteboard and want to work
with an application.

Action Method
Close the Digital Ink Pt
Layer A TN \
(CHOVES),
Save Ink

Always Save Ink

+ ' + Ink Laver Options, ..

Clear Ink

Close Ink Layer

Restoring notes

If you accidentally clear your notes by closing the Digital Ink Layer, you can restore them.

Action Method

Restore Notes

Click here to
regtare ink.

)

N
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Hands-on Practice

Try the following tasks to test your knowledge

Open your Internet browser using the SMART Board interactive white-
board

Use the On-Screen Keyboard to enter the address for a web page in
the address bar

Use a Pen Tool to draw over the web page

Capture an image of your drawing into SMART Notebook software

Close the Digital Ink Layer

Restore your drawings

Ooooon
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Ink Aware

Introduction

You can write and draw directly into Ink Aware files. Insert your writing as text or graphics instead
of writing on the Digital Ink Layer.

There are several Ink Aware applications, including Microsoft Office and Open Office.org
applications. This document provides information on Microsoft Office applications.

Points to consider

Ink Aware functions are different in each aplication. The following points apply to Ink Aware
Microsoft Office applications:

» When you pick up the pen tool, the SMART Aware Toolbar appears instead of the Digital Ink Layer
NoTE: The SMART Aware Toolbar may appear in other toolbars, or as a floating toolbar. If the

SMART Aware Toolbar is not visible, select View > Toolbars > SMART Aware Toolbar from the
menu.

SMART Aware 1™ =
&y &Ry [@ Settings -

* You can write anywhere on the document

Touch the interactive whiteboard where you want to insert the writing
» Press a button on the SMART Aware Toolbar to insert writing into the document

e Save your writing in your document or capture it to a SMART Notebook file

In Microsoft PowerPoint presentation graphics program, the SMART Aware Toolbar appears as
a floating toolbar in the normal view, and the slide show toolbar in presentation view. For more
information, see Writing over a Microsoft PowerPoint presentation on the following page.

Inserting writing into a document

Action Method

Insert writing as text Touch where

you want to
\[\{\/\\Ve/ + insert the text + u+H
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Action Method

Insert writing as a Touch where

graphic / you want to
/\J' + insert the + o

graphic
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Writing over a Microsoft PowerPoint presentation

» The SMART Aware toolbar is not visible when you use an interactive whiteboard to present a
PowerPoint software file

* Press the Command Menu button on the Slide Show toolbar =y
to access the Ink Aware features « _Elv =
Al
* You do not need to insert your notes each time you write. You will be prompted to insert your
notes into the document at the end of the presentation

Saving your writing

« If you used the Insert as Text or Insert as Drawing buttons as explained above, when you save
the file, your writing will save with it

* You can also use the Capture tool to save an image of your work : - _
into a SMART Notebook file. : kg ?JE}E&'“EIS z !




Hands-on Practice

Try the following tasks to test your knowledge

At your computer, create a brief two-question quiz using Microsoft
Word

At the interactive whiteboard, open the quiz and use a Pen Tool to write
the answers to the questions

Insert the answers as text into the document

Save the file including the answers

00 oo
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Working with SMART Notebook software

Introduction

SMART Notebook software is designed to use with a SMART Board interactive whiteboard. You
can use it to create interactive and collaborative presentation materials. The intuitive interface
makes it easy to use.

SMART Notebook software lets you:

» Draw or write on the pages using the pen and eraser tools from the pen tray or the SMART
Notebook software toolbar

Access thousands of learning objects in the SMART Notebook software Gallery

Attach documents, shortcuts and hyperlinks to the SMART Notebook file for easy access

» Reorder, copy and delete pages

Add an unlimited number of pages

Creating a SMART Notebook file

Action Method
Open SMART
P i
Notebook software iotebook... ™
‘%; 4 OR Eec_order.
Wideo Player. ..
keyboard. ..

Show Floating Tools
Instant Conferencing. ..

Welcome to Notebook...




The SMART Notebook software interface includes four main parts:

1 Work area — lets
you work with
objects, including
handwritten
notes, typed text,
graphics, clip art
and Flash® files

2 SMART
Notebook
software toolbar
— provides tools
for creating and
presenting files

3 Menu bar -
provides text-
based options

4 Side Tabs —
provide additional
tools and features

& Untitled - SMART Notebook

2

Extend Pace

Groupl

1

Jun 2412213 P

Auto-hide

3

Action

Method

Add a blank page

o]

Navigate to the next
or previous page

==




Organizing and enhancing pages

The Page Sorter tab lets you see an overview of all pages in the SMART Notebook file, navigate to
a different page and reorder the pages.

Action Method
See all pages T
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Action Method

Duplicate an [
Groups Ce Groups Ce

existing page I

Groupl I J
:;'l =] [ —
) \ —_— Delete Page Del
| - Clear Page Chrl+L
’Inswlaﬂag& m+M
~ Clone Page Chrl+D
Ry -
) 2 Screen Shade
HA
— Add Page to Gallery
B |
Add learning
objects from the Type search terms here
Gallery !
&= | Type search terms here b Q&-‘ & —

Q SMART Learning Marketplace
+- £ My Content
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| Interactive and Multirmedia {80}

| Motebook Files and Pages (31)
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Attaching external files and links

You can attach supporting documents, shortcuts and web links to a SMART Notebook file to keep
your documents organized and improve the flow of your lesson.

There are three types of attachments you can add to a SMART Notebook file:
» Copy of File — stores a copy of the document in the SMART Notebook file

» Shortcut to File — stores the file path on your computer and minimizes the size of your SMART
Notebook file

» Hyperlink — links to a website



You can access attachments by pressing the Attachments tab or a linked object on a SMART

Notebook page.
Action Method
Add an attachment —
L\- I Insert Copy of File
I Insert Hyperlink,
E] Insert Shortout To File
&,
@A
-
Open an attachment e — e~ =
L- @Worksheet.xls ------- .
; Motebook, notebook,
=2 +
&, )
[ — -
Formatting objects
Anything you add to the SMART Notebook [ T |
page is an object, including Gallery items or i e l L3
items created with a pen tool. After you add an i G .y : l
object, you can format or animate it by l P' — | E
selecting the object and clicking the 2 S
Properties tab. The options that appear b SRS C
depend on the type of object that you selected. ® y o 2
@A |\
(%) solid fill -
() Gradient Fill P
() Pattern fill
() Image Fill
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Customizing your workspace

You can customize the SMART Notebook software interface to suit your delivery style and
classroom needs.

Option Press

Change the toolbar

location L/%—f/ﬁ%/ﬁélﬁca
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Option Press

View more than one -5 AEIGY TRQED TS L7/ 8/ R A IR

page at a time 2, _
&
=

Hands-on Practice

Try the following tasks to test your knowledge

Create a new SMART Notebook file

Add a new page

Use a Pen Tool to write your name on the first page

Add an object from the Gallery to the second page

Move the page with your name on it to the end of the SMART Note-
book file

Attach a file

View both pages at once using Dual Page Display

Return to Single Page Display

OO 0000nno
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Working with objects in SMART Notebook software

Introduction

Anything that you can select on the SMART Notebook page is an object. Each object can be moved,
resized or rotated. You can also change additional properties depending on the type of object.

You can add an object to a page using the following methods:
* Typing text

» Drawing or writing in the work area

Using the drawing tools on the SMART Notebook software toolbar
« Inserting content from the Gallery, your computer or the Internet
» Capturing an area of your screen with the Capture tool

Creating your own objects

The easiest way to create an object is to pick up a pen tool and write or draw on the SMART
Notebook page.

You can also use the drawing tool buttons on the SMART Notebook software toolbar. You can
customize most drawing tools by using the tool button’s sub-menus.

V4
(B =" [&®]]

Action Method

Ve - A

£ | 4
o - A

Write or draw a
freehand shape




Action

Method

Erase your writing or
drawing

 +

Create a shape

Create a straight line

Create a text object

Create a table




Searching for Gallery objects

The Gallery contains thousands of images, pages, videos and Flash files that you
can add to your SMART Notebook file. There are two ways to find content in the

Gallery:

» Browse the Gallery collection folders

» Search by keyword

Africa Cote d'Ivoire

Task Method
Search by keyword 1 Open the Gallery tab 2 e s e v =13
2 Type a search term in =5 S — | L
the Search bOX {} online Essentials for Educators
] Themes ':]
3 Press to begln +-£ Essentials for Educators L
+ & Lessaon Activity Toolkit 1.0 —_—
the searcn +-£5 Gallery Sampler 1
‘}-) Search Results for map of afri é;
4 Search results appear v
. 4 *
in the lower frame BA
Search Results for map of ~ —
africa
14 itemns é)
TERElatad Folders (4} 4
4 | Pictures and Backgrounds {10)
4 =
]
Africa Cote d'Ivoire - a\
[¥] Auto-hide
Add a Ga”ery ObjeCt | 4 | Pictures and Backgrounds (10) |
to a page - =
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Manipulating objects

Press or click an object to select it. Two handles and a drop-down menu arrow appear.

Action Method

Rotate an object

Resize an object

b

The object drop-down menu provides access to additional actions. Flip and Clone are examples of
these actions:

Action Method

Flip an object

Clone Chrl+D
Cuk Chrl4+
Copy Chrl+C
Paste Chrl+y
/ Delete Del
i S
TS ! pLr
3 Locking 3
s [
# Fip S

e —— -

Infinite Cloner

Link...
Sound...
Properties...




Action Method

Create a copy of an ®
ObJeCt " Clone CtrI+D\
S — - T
Copy Chrl+C
Paste Chrl+y
Delete Del
Locking 3
Flip 3
W order 3

Infinite Cloner

Link...
Sound...
Properties...

Modifying object properties

The Properties side tab lets you make changes to an object. Using this tab,
you can modify the following object properties: BA

* Line style

e Text style
* Fill
» Animation

The options that are available in the Properties tab vary depending on the object that you have
selected. If no object is selected, changes will affect the background of the SMART Notebook page.

Action Method
Change object 1 Select the object you want to modify
properties 2 Press the Properties tab

3 Press the button for the property you want to change

4 Select properties from the options provided. The changes are
visible immediately.




Capturing an image

You can use the Capture tool to capture anything that is displayed on your screen and use it as an
object in a SMART Notebook software file. When you press the Capture button, the Screen
Capture toolbar appears.

Action Method

Open the Capture . :
toolbar riﬁwuiﬂl

Capkure bo new page

Button Captured image
=] A rectangular area
[T The active window

M-

i The entire screen

@ A freehand shape

The captured image appears in a new SMART Notebook page as an object.

You can access the Screen Capture toolbar when you are not using SMART Notebook software.
Press the SMART Board icon in the Windows Notification area. Select Other SMART Tools >
Screen Capture Toolbar.




Hands-on Practice

Try the following tasks to test your knowledge

Create an object using each of the drawing tools found on the
SMART Notebook software toolbar

Use the Properties tab to modify the color, line style and text style of
the objects

Create a table with two rows and two columns

Find a map of your country using the Gallery search tool

Add the map to the SMART Notebook page

Flip, rotate and clone the map

00000

Experiment with the other options found in the object drop-down menu
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Advanced SMART Notebook software features

Enhance the appearance of your SMART Notebook file

Feature

Function

Themes

Apply a consistent background to one or all SMART Notebook pages

Spell Check

Check text spelling

Alignment Guides

Align objects horizontally or vertically

==&

Fill Effects
D)
Solid Gradient Pattern Image
Organize your work
Feature Function
My Content Add your own objects to the

Gallery and save your
favorite items

=9 My Content
E# Grade 7a Science
% Grade 7b Science

=-F% Grade 8 Science

+-FH Fluids
*- Magnetisrm =]
E# Grade 9 Math
=% Temnplate iterns

e m|c




Feature Function

Page Grouping Sort your pages into groups

Hint: Edit your groups by using drag and ...

_ [Intrnductuw Pages

==

i'elcom Sign-in sheet  Trainer Intro... Agenda

_ P\ctivities

2“1:1?- Famwy

Integrate interactive media into your lessons

Feature Function
Show All Links Highlight all linked = — .
X -5l A Is I | ]
objects A=) _—— [P
Animation Spin, fade in, shrink
Page Recording Record and play back actions
on a SMART Notebook page I‘ I I ’ u
Back Pause Play  Record




Present your SMART Notebook file

Feature Function
Pin Page Keep one page locked in place in Dual Page Display

© ©

=" 7

Magic Pen Create a Spotlight, Magnifier or write in disappearing ink
Screen Shade Cover information and reveal it slowly during a presentation
1 9 193
hits suths ams. As the crops die. e ‘black bluzeards” began. Dust {rom the over-plowed
1 913"2‘ of dust storms is incressing. Fourween are reported (I;::_-\.‘Jf. nexi vear there will be 38
x|
r

You can find additional information about these and other features in the SMART Notebook
software Help file. To access Help, select Help > Contents from the menu bar.

Hands-on Practice

Try the following tasks to test your knowledge

D Create a two-page SMART Notebook file using three of the advanced
features listed in this section
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Using SMART Tools effectively

Introduction

SMART Notebook software includes several tools that enhance your use of the SMART Board
interactive whiteboard. SMART Tools let you do the following:

» Access the tools that you use most frequently
» Focus attention on a particular area of the display

* Integrate multi-media files into your presentation

Type text
» Configure the SMART Board interactive whiteboard

You can use SMART Tools while working with any application on the SMART Board interactive

whiteboard. Click the SMART Board icon (o] in the Windows notification area to access the
SMART Tools. —

Accessing frequently used tools

Use the Floating Tools toolbar to access the tools and features that you use most frequently on the
interactive whiteboard.

The Floating Tools toolbar floats on top of other applications and can be:
* Moved anywhere on the screen
* Minimized or hidden

» Customized to include the tools that you find most useful

Task Method
Open the Floating Recorder. ..
Tools wideo Player...

fogboud- .
how Floating Tool
————— Lo oot ook
ol - Instant Conf ing. ..
*‘); l].‘ .57 PM Instant Conferencing

Welcome to Notebook...




Task Method

Hide, reveal and
move Floating Tools K C
3 5
>
ol
g
¢ \ —
e X
e y
ad
4| -
L £
&y e
4 : 2 =
e

Add or remove items

to Floating Tools a e e e ot et e

é\:@; I & A V4 & V4

& / 2 o) ¢
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Drawing attention to part of the screen
Tool Function
Screen Shade Gradually reveal information or hide text

and graphics by dragging the shade
vertically or horizontally




Tool Function

Spotlight Draw the attention of your audience to a
specific part of the screen

Magnifier Enlarge small text or images ==
@ T
f =[3.14"B5)
OgE =g —
Pointer Direct audience attention to an 51000
important piece of information . 4577
35,47
41250
Configuring the SMART Board interactive whiteboard
Tool Function
Control Panel Configure a variety of software and hardware options =
Orient Orient the image of the desktop on
the surface of the interactive 4
whiteboard

Integrating multimedia into your presentation

Tool Function

Recorder Record actions on the interactive whiteboard

Mérg = || 000C00




Tool Function

Video Player Play video files and write or draw over video
Typing text

Tool Function

On-Screen Keyboard | Type or edit text in any application

Hands-on Practice

Try the following tasks to test your knowledge

D Launch and customize the Floating Tools toolbar

D Experiment with two SMART Tools
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